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Lab Activity 
File Management with Windows Explorer 

Windows XP, Vista, Windows 7 and Windows 8 
Brought to you by RMRoberts.com 

 
 
After completing this laboratory activity, you will be able to: 
 

o Open and navigate Windows Explorer. 
o Interpret the symbols and structures used in Windows Explorer. 
o Display hidden and system files in Windows Explorer. 
o Reconfigure the details view of files and directories to reveal enhanced properties. 
o Sort files by characteristics, such as date created, size, and alphabetical order. 
o Modify Windows Explorer to view additional file details. 
o Compare and contrast Windows operating system file structures. 

 
 
Introduction 
 
This laboratory activity will enhance your skills for using Windows Explorer and navigating directory 
structures.  Never before has Microsoft had four versions of its operating system released at the 
same time.  Windows XP will continue to be supported until mid-2014, and maybe longer.  Even after 
Windows XP is no longer supported, there will be three different operating systems  This is a very 
difficult time for novice computer technicians to be studying computer repair.  The understanding of 
the directory structure is vital to computer repair.  Also, be aware that certification tests often have 
questions related to directory structure.  For example, you might be asked where the individual User 
folders are located or to define the complete path to a specific file.  As you go through this laboratory 
activity, you will see the need to practice directory navigation for all the different operating systems.  
 
The Windows file structure is revealed in different ways depending on which operating system you 
are using.  
 

 Windows XP – Right-click My Computer | Explore or Open 
 Windows Vista – Right-click Computer | Explore or Open 
 Windows 7 – Right-click Computer Open 
 Windows 8 – Select Computer App 

 
The display should be similar to that shown in the following screen capture. 
 

http://www.rmroberts.com/
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Typical file structure screen captures for Computer XP, Computer Vista, Computer Win 7 Computer Win 8. 

 
Notice that system tasks are listed in the left pane of Windows XP Explorer.  In the next versions of 
the operating system starting with Vista, task options in the left pane of Windows XP was redesigned 
to display the system navigation with locations in the directory structure such as desktop, downloads, 
public, documents, network, and more.  Tasks were moved to the tool bar area above the viewing 
panels in Windows Vista and Windows 7 as well.  Windows 8 then, introduced the term “Ribbon” for 
the area above the viewing pane that serves the same purpose as the previous tool bar.  The tasks 
are directly related to the item selected in the navigation pane.  For example, when the Documents 
folder is select, tasks are displayed relating directly to the Documents folder such as “New Folder” or 
“Delete”. 
 
In the first or top level of the directory structure, you can see icons for all available storage devices, 
including the floppy drives, hard drives if present, and optical disc drives.  Double-clicking a drive or 
directory icon reveals the next level of folders and files for that drive or directory.  For example, 
double-clicking a drive icon reveals a detailed view of the directory structure of the drive.  In the 
following screen capture, you can see a typical directory structure of a C drive for a Windows XP 
computer.  This view was created by double-clicking the Local Disk (C:) icon. 
 
The second common method for revealing the directory structure in Windows XP, and Vista Not 
(Windows 7) is to open the Start menu, right-click My Computer for Windows XP, Start menu, right-
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click Computer for Windows Vista, and then select Explore from the shortcut menu.  There is no 
explorer option in Windows 7 after right-clicking the Start menu Computer.  There is no Start menu 
option in Windows 8.  When this method is used, the left pane will display the directory structure by 
default rather than the common tasks view.  Look at the following screen capture to see what a typical 
directory tree view using the right-click method would reveal.  Windows 7 and Windows 8 reveal 
similar directory structure by double-clicking on the C: drive. 
 
 
 

 
The default C Drive Comparison made from 4 different operating systems XP, Vista, Win 7and Win 8. 

 

In the screen capture, you can see the files and folders found under drive “C:” for Windows operating 
systems.  (These are typical drive C directory structures; however, it may not necessarily match the 
one on the computer you are using.)   This is the preferred view of the directory structure for 
technicians because it displays the hierarchy of the file system structure.  This means that the 
Explorer window allows you to see a detailed display of files, directories (folders), and paths all at one 
time.  You can change back and forth by clicking the Folders button located in the toolbar. 
Note that Windows Explorer displays information about the files and their structure by default in two 
panes.  The pane on the left displays the path structure (the available drives, directories, and 
subdirectories) as an expandable and a collapsible tree.  The pane on the right displays the contents 
of the directory or subdirectory selected on the left . At times Windows Vista, Windows 7 and 
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Windows 8 will have three panes displayed.  The pane on the right is the preview pane that displays 
the contents of a file selected in the center pane.  The three-pane display is not always enabled by 
default.  There will be more about the three pane display in the individual lab activities. 
 
To select a new directory, click the directory’s icon.  To expand or collapse a branch in the directory 
tree, double-click the directory’s icon or click the box to the left of the folder icon.  In the previous 
screen capture, drive C is highlighted on the left.  The files and directories contained in the drive’s 
root directory are displayed on the right. 
 
The latest Windows Explorer systems are similar in many ways to that of Windows XP, but there are 
also many differences.  For example, the commonly accessed tasks are not displayed in the left pane 
the way they are in Windows XP. 
 
Windows XP Explorer and later systems use drive C as the default directory or root directory.  The 
term root directory refers to the first directory created on a drive when the operating system is first 
installed and where the files required to boot the computer operating system are installed. 
 
Take special notice of the plus (+) and minus (–) signs in the small boxes to the left of the directory 
structure in Windows XP. A directory that contains unexpanded subdirectories is indicated by a plus 
sign (+) in front of the directory name.  Clicking the box expands, or reveals, the subdirectories in the 
directory tree.  When the subdirectories are expanded, a minus sign replaces the plus sign in the box.  
 
Directories that contain no subdirectories have no box to the left of their folder icon.  Windows Vista 
and later dropped the use of the plus and minus sign in a box, and simply uses a folder to indicate a 
directory. 
 
Certain files and folders (directories) are hidden by default.  For example, the files required to boot 
the computer system are hidden to prevent accidentally moving or deleting the files.  Hidden files and 
folders can be revealed by the system administrator or a user with security equal to the system 
administrator.  To display hidden and system files in Windows XP Explorer, select Tools from the 
menu  and then select Folder Options as indicated in the following screen capture. 
 
A Folder Options dialog box similar to the following will be revealed.  Select the View tab to reveal a 
list of viewing options that can be selected using a simple mouse click.  Look at a partial list of options 
below. 
 
A dialog box very similar to the Windows XP Folders Option dialog box will appear. Look at the 
following screen capture of the Folder Options dialog box in Windows 8, and compare it to the 
Windows XP version shown earlier. 
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Compare Windows XP and Windows 8 and you can see how similar the options are under the View tab. 

 
Pay particular attention to the three options: Do not show hidden files and folders, Show hidden 
files and folders, and Hide protected operating system files (Recommended).  By default, the Do 
not show hidden files and folders, and Hide protected operating system files (Recommended) 
is selected.  You select the appropriate option to view hidden and system files in Windows Explorer. 
Also, note that there is a button in the lower-right corner labeled Restore Defaults, which is used to  
happens when the hidden and system files are revealed in the directory structure. return the settings 
to their original condition.  Compare the following screen captures to see what  
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The screen capture shows how Windows 8 looks with and without the Hide system Files options. 

 

The hidden and system files are displayed lightly rather than sharp and crisp. This is so they can be 
easily distinguished from regular files. The appearance is very similar in all versions of Windows 
operating system. 
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As you can see, the Windows XP and Windows 8 Folder Options dialog boxes are very similar and 
have not really change much over the years. The real difference is how to access them.  You can 
also access the Folder Options dialog box through the Control Panel.  
 

 For Windows XP, select Start | Control Panel | Appearance and Themes | Folder Options 
| View.  

 For Windows Vista, select Start | Control Panel | Appearance and Personalization | 
Folder Options | View. 

 For Windows 7, Select Start | Control Panel | Appearance and Personalization | Folder 
Options | View. 

 For Windows 8, Select Search Charm |Apps |Control Panel |Appearance and 
Personalization |Folder Options | View. 

 
The details view of files and folders in all Windows Operating systems is the preferred method of 
technicians to view the directory structure.  In addition to the default details view, you can modify the 
view to include many different file options.  For example, you can include much more file information 
in the Windows Explorer detail view.  You can add additional information columns for such things as 
file extensions, author, URL, product version and much more. 
 
The number of details about files has been greatly increased in Windows Vista and later systems. 
Many of the details include Web page information and information that is typically stored in Microsoft 
Office application documents. 
 
You access the Choose Details dialog box in the same way for all versions of Windows.  Simply right-
click the top row of any column in the detail view of Windows Explorer to reveal the “More” option. 
Clicking the More option reveals a complete list of available details as shown in the following screen 
capture. 
 
Below you can see the results from right-click at the top of the column. A list of details is revealed. 
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 A comparison of Windows XP and Windows 8 as to how to display additional file information. 

 
To generate a list of more file detail options simply select the “More…” option and a much longer list 
of file details can be chosen from.    
 
Below is a screen capture comparison of Windows XP and Windows 8 choose file details options. 
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Choose additional file details for Windows XP and Windows 8. 

 

After the detail is selected, a new column is automatically generated to the right side of the existing 
columns.  If the column is empty, it means that there are no such file details available for the file. 
Since many of the file details depend on the proper configuration of application software, the details 
selected may not appear in the column.  For example, if you do not enter information into the Author 
textbox in a Properties dialog box for a Microsoft Office document, then the Author column detail will 
be blank. 
 
You can sort the files by double-clicking the top of anyone of the detail view column headings.  For 
example, double-clicking the file name rearranges the file name list in alphabetical order; 
double-clicking the size of the file automatically rearranges the column list by file size; double-clicking 
the file type reorganizes the files by file types, such as documents, or images. 
 
There have been many significant changes to the Window operating system file directory structure. 
Some of the most significant changes are listed below by operating system and feature. 
 

 Windows XP introduced “Shared Documents” folder. 
 Windows Vista introduced a single “Public” folder. 
 Windows 7 introduced multiple “Public” folders such as Public Documents, Public 

Downloads, Pubic Music, Public Pictures, and Public Movies. 
 Windows 7 introduced HomeGroup. 
 Windows 7 introduced “Libraries” folder. 
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 Windows XP the User accounts were located under “C:\Documents and Settings” 
folder. 

 Windows Vista, Windows 7 and Windows 8 the User accounts are listed under the C: 
\Users or default drive partition under the “Users” folder. 

 Windows Vista has a preview pane but it was not enabled by default. 
 
 

Folder Name Changes and Additions Chart 

OS     

Windows XP My Computer My Documents   

Windows Vista Computer Documents Public Folder  

Windows 7 Computer My Documents Public Folders + Home Group 

Windows 8 Computer My Documents Public Folders + HomeGroup 

 
Public Folders + -Public Downloads, Public Documents, Public Music, etc. 
 
Be prepared to answer file system directory structure questions on the CompTIA certification 
examination.  
 
For more information about Windows 7 files and folders. 
http://windows.microsoft.com/en-US/Windows7/Working-with-files-and-folders 
 
For more information about windows Vista files and folders 
http://windows.microsoft.com/en-US/windows-vista/Working-with-files-and-folders 
 
You may also conduct an Internet search using the key terms “Working with files and folders” and 
include the desired operating system such as Windows 8. 
 
Equipment and Materials Required 
 Computer with Windows XP or Windows Vista, Windows 7 and Windows 8. 
 USB Flash drive with memo1 file (optional). 
 
Part I—Windows XP 
Procedure 
 1. ___ Report to your assigned workstation. 
 2. ___ Boot the computer and verify it is in working order. 
 3. ___ Click the My Computer icon located on the Start menu to open the My Computer   
  window. 
 4. ___ Double-click the Local Disk (C:) icon and observe the result. 

5. ___ Close the My Computer window(s). Right-click the My Computer icon, and select 
 Explore from the shortcut menu. This opens Windows Explorer. 
6.___ After opening the Windows Explorer window, try clicking on the plus sign of drive C in 
 the left pane to expose the directory structure below it. Click each of the subdirectories 
 in the left pane that have plus signs in front of their names. This will show you how the 
 file structure is designed and what files are inside the directories. Close Windows 
 Explorer. 

http://windows.microsoft.com/en-US/Windows7/Working-with-files-and-folders
http://windows.microsoft.com/en-US/windows-vista/Working-with-files-and-folders
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7.___ Right-click the My Computer icon and select Explore from the shortcut menu. Locate the 
 Folders option at the top of Windows Explorer. Click the Folders icon repeatedly and 
 watch how the left pane changes between the systems tasks view and the directory tree 
 view. 
 

 
 
8.___Select the My Documents folder from the left pane and leave it so that it is highlighted 
 in blue. 
9. ___ Select the View menu at the top of Windows Explorer and then select Choose Details 
 from the drop-down menu. You should see a list of file details similar to those in the 
 following screen capture. 
 
Select the following file details: Attributes, Owner, and Date Created. To do this, simply click 
the square box in front of the file detail. 
 
10. ___ Now, look at the My Documents directory using Windows Explorer to see the changes 
 in the appearance of file details. Three additional columns should have been added with 
 information about the additional file details requested. 
11. ___ Deselect the file details for Attributes, Owner, and Date Created to return the Windows 
 Explorer view to its default state. To deselect the file details, simply click the box in front 
 of the detail you wish to deselect. 
12. ___ Now, click the titles at the top of each column to see the effect on the column listing. 
 For example, clicking the Date Modified title at the top of the column will automatically 
 reorganize the contents of My Documents in ascending or descending order by the date 
 the file or directory was modified. Repeat for the columns labeled Size, Type, and 
 Name. Experiment for a few minutes before moving to the next step. 
13. ___ Now, you will reveal the hidden files and folders. Select Start | Control Panel | 
 Appearance and Themes | Folder Options | View. Select the Show hidden files and 
 folders option and deselect the Hide protected operating system files option. 
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XP Folder Options 

 
You simply select “Show hidden files and folders” and “Hide protected operating system files 
(Recommended) by one click of the mouse left button.  

 
14. ___ View drive C using Windows Explorer and see if you can identify the hidden and  
 system files. See if the following files can be seen: ntdlr, autoexec.bat, io.sys, 
 pagefile.sys, msdos.sys, and boot.ini. These system files should appear in the directory 
 structure. They are normally hidden. 
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XP Exposed system files 

 
 
Your view should be similar to the one in the screen capture above. 

 
15. ___ Return the Folder Options dialog box back to default settings, by opening the Folder 
 Options dialog box, clicking the View tab, and then clicking the Restore Defaults button. 
 Be sure the View tab has been selected and not the General tab. Each tab has a 
 Restore Defaults button, but the button will only affect the options appearing in that 
 particular tab when selected. 
16. ___ This concludes Part I of the laboratory activity. Do not answer the review questions 
 until you complete all parts of the laboratory activity. You can take a few minutes to 
 review Part I before moving on to Part II. 

 
 
Part II—Windows Vista 

 
Vista made vast improvements to the way the user navigates the directory structure. Look at 
the screen capture below and you can see how the Windows Explorer makes navigation so 
much better than the previous version Windows XP. 
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The Vista Navigation Pane 

 
The navigation pane on the left displays the hierarchy of the directory structure. The forward 
and back buttons will move you up and down the directory structure.  The View Options menu 
will change the size and style of the files and folders display in the middle pane.  The search 
box is an invaluable tool for locating files and folders in the directory structure.  One of the 
most common problems encountered by computer users is locating their files on the computer 
system especially after a long period of time.  
 
The preview pane on the right is new in Vista but it is not enabled by default. To enable the    
preview pane you must have a computer capable of support Windows AERO feature and then 
select the Organize menu and the select Layout and then select Preview Pane. Look at the 
screen capture below and you can see how to enable the Preview Pane feature in Windows 
Vista. 
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Vista Layout Preview Pane 

 
The tool bar options across the top of Windows Explorer will change according to the type of 
file or folder selected. For example, if you select  

 
Procedure 
 1. ___ Report to your assigned workstation. 
 2. ___ Boot the computer and verify it is in working order. 
 3. ___ Click the Computer icon in the Start menu to open the Computer folder in the system  
  tasks view. 
 4. ___ Double-click the Local Disk (C:) icon and observe the result. 

5. ___Close the Explorer program. From the Start menu, right-click the Computer icon, and 
 select Explore from the shortcut menu. This opens Windows Explorer in the directory 
 tree view. 
6. ___ After opening Windows Explorer, click drive C to expose the directory structure. Click 
 several of the drive C subdirectories in the left pane to expand the contents. This will 
 show you how the file structure is designed and what files are inside the directories. 
 Close Windows Explorer. 
7. ___ In the Start menu right-click the Computer icon and select Explore from the shortcut 
 menu. Locate and click the Folders label in the left pane. Notice how it jumps to the 
 bottom of the left pane when closed. Click the Folders label repeatedly and watch how 
 the left pane changes between the directory tree view and no view. 

 8. ___ In the left pane, click the user account name you are using and then click Documents. 
9. ___ Select Views from the menu at the top of Windows Explorer and then select Choose 
 Details from the drop down menu. 
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10. ___ Now, right-click the top of the column labeled Name. A shortcut menu should appear. 
 Select More from the bottom of the down menu. The Choose Details dialog box should 
 appear. Select the following file details: Attributes, Owner, and Date Created. To do 
 this, simply click the square box in front of the file detail. The list of file details available 
 in Windows Vista is quite long. You will need to use the scroll bar to view the entire list. 
11. ___ Look at Documents directory using Windows Explorer to see the changes in the 
 appearance of file details. Three additional columns should have been added with 
 information about the additional files details requested. 
12. ___ Deselect the file details for Attributes, Owner, and Date Created to return the 
 Windows Explorer view to its default state. To deselect the file details, simply click the 
 box in front of the detail you wish to deselect. 
13. ___ Click the titles at the top of each column to see the effect on sorting the contents of the 
 listing. For example, clicking the Date Modified title at the top of the column will 
 automatically reorganize the contents of the Documents directory in ascending or 
 descending order by the date the file or directory was modified. Repeat for the columns 
 labeled Size, Type, and Name. Experiment for a few minutes before moving to the next 
 step. 
14. ___ Now, you will reveal the hidden files and folders. Select Start | Control Panel | 
 Appearance and Personalization | Folder Options | View. Select the Show hidden 
 files and folders option and deselect the Hide protected operating system files option. 
15. ___ View drive C using Windows Explorer and see if you can identify the hidden and 
 system files. See if the following files can be seen: bootmgr, pagefile.sys, autoexec, 
 ntldr, io.sys, msdos.sys. These system files should appear in the directory structure. 
 They are normally hidden. 
16. ___ Return the Folder Options dialog box back to default settings, by opening the Folder 
 Options dialog box, clicking the View tab, and then clicking the Restore Defaults 
 button. Be sure the View tab has been selected and not the General tab. Each tab has a 
 Restore Defaults button, but the button will only affect the options appearing in that 
 particular tab when selected. 
17. ___ Take a few minutes to review the laboratory activity. Practice accessing the Folder 
 Options dialog box without the aid of your lab manual. 
18. ___ Complete the review questions. When you are finished answering the review question, 
 return the computer to its original configuration and shut down the computer. 
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Part III Windows 7 
 

The Windows 7 Explorer layout of panes is very similar to Windows Vista.  
 

 
Navigation Panes Windows 7 Labeled 

 
Two new folders in the left navigation pane are Libraries, and Homegroup.  Libraries - is a 
collection of files and folders from multiple locations.  Homegroup is a new way of sharing files, 
folders and media.  There will be much more about these two new files in future laboratory 
activities.  The object of this laboratory activity is to familiarize you with the basics for file 
navigation in Windows 7.  You can use the screen capture to assist you during this section of 
the laboratory activity. 

 
Procedure 

 1. ___ Report to your assigned workstation. 
 2. ___ Boot the computer and verify it is in working order. 
 3. ___ Click the Computer icon in the Start menu to open the Computer folder in the system  
  tasks view. 
 4. ___ Double-click the Local Disk (C:) icon and observe the result. 

5. ___ Close the Explorer program. From the Start menu, right-click the Computer icon, and 
 select Open from the shortcut menu. This opens Windows Explorer in the directory tree 
 view. 
6. ___ After opening Windows Explorer, click on drive C in the left pane to expose the directory 
 structure. Click several of the drive C subdirectories in the left pane to expand the 
 contents. This will show you how the file structure is designed and what files are inside 
 the directories. Close Windows Explorer. 
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7. ___ In the Start menu right-click the Computer icon and select Open from the shortcut 
 menu. Locate and click the Folders label in the left pane. Notice how it jumps to the 
 bottom of the left pane when closed. Click the Folders label repeatedly and watch how 
 the left pane changes between the directory tree view and no view. 
8. ___ In the left pane, navigate to your user account name for example C: | USERS | Richard 
 |My Documents. The example uses “Richard” for the account user name; you should 
 use your account user name. 
9. ___ Select View Display Options from the menu at the top of Windows Explorer and watch 
 how the center pane folders and files change. Repeat clicking on the View Display 
 Options until you have seen all the various options for displaying the files and folders. 
 

 
 

10. ___ Now select the Preview Pane on and off option from the menu list at the top of the 
 window. Notice how the preview pane provides a preview of the file contents. Select 
 different files to see the difference. 
 

 
 

11. ____ Now select the View Display Options until Explorer displays file details. An example 
of the detail view is below. 

 

 
 

12. ___ Now, right-click the top of the column labeled Name. A shortcut menu should appear. 
 Select More from the bottom of the down menu. The Choose Details dialog box should 
 appear. Select the following file details: Attributes, Owner, and Date Created. To do this, 
 simply click the square box in front of the file detail. The list of file details  available in 
 Windows Vista is quite long. You will need to use the scroll bar to view the entire list. 
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14. ___ Look at My Documents directory using Windows Explorer to see the changes in the 
 appearance of file details. Three additional columns should have been added with 
 information about the additional files details requested. 
15. ___ Deselect the file details for Attributes, Owner, and Date Created to return the Windows 
 Explorer view to its default state. To deselect the file details, simply click the box in front 
 of the detail you wish to deselect. 
16. ___ Click the titles at the top of each column to see the effect on sorting the contents of the 
 listing. For example, clicking the Date Modified title at the top of the column will 
 automatically reorganize the contents of the Documents directory in ascending or 
 descending order by the date the file or directory was modified. Repeat for the columns 
 labeled Size, Type, and Name. Experiment for a few minutes before moving to the next 
 step. 
17. ___ Now, you will reveal the hidden files and folders. Select Start | Control Panel | 
 Appearance and Personalization | Folder Options | View. Select the Show hidden files 
 and folders option and deselect the Hide protected operating system files option. 
18. ___ View drive C using Windows Explorer and see if you can identify the hidden and 
 system files. See if the following files can be seen:   program files, autoexec, boot, 
 config.sys, IO.sys. These are system files and should appear in the directory structure. 
 They are normally hidden. 
Notice how they compare to other files that are not normally hidden. They should be lighter in 
appearance. 
 
19. ___ Return the Folder Options dialog box back to default settings, by opening the Folder 
 Options dialog box, clicking the View tab, and then clicking the Restore Defaults button. 
 Be sure the View tab has been selected and not the General tab. Each tab has a 
 Restore Defaults button, but the button will only affect the options appearing in that 
 particular tab when selected. 
20. ___ Take a closer look at the left navigation pane. Locate the following folders and study 
 their relationship to other folder locations. Users, Public, Public Documents, 
 Libraries, Desktop, Downloads, Windows, and Homegroup. 
21. ___ Take a few minutes to review the laboratory activity. Practice accessing the Folder 
 Options dialog box without the aid of your lab manual. 
22. ___ Complete the review questions. When you are finished answering the review question, 
 return the computer to its original configuration and shut down the computer. 

  
 
 
Part IV Windows 8 
 

The biggest change in the Windows 8 navigation window is the new design of the toolbar 
which is now called the Ribbon or Ribbon tool bar. 
Most of the other features covered in this laboratory activity are the same as Windows 7 and 

Vista. 
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Navigation Panes Windows 8 Labeled 

 
Use the screen capture to assist you in this portion of the laboratory activity. 

 
Procedure 
 
 1. ___ Report to your assigned workstation. 
 2. ___ Boot the computer and verify it is in working order. 
 3. ___ Select the Search charm to reveal the system Apps. 

4. ___ Select Windows Explorer. 
5. ___ Look at the left pane and study the navigation structure. You should see folders 
 identified as Desktop, Downloads, Libraries, Documents HomeGroup and your 
 current User Account name. If not, call your instructor for assistance. 
6. ___ Select the Documents folder in the left pane under Libraries. 
7. ___ At the top of the Windows Explorer Ribbon, select the Home tab and review the menu 

 options. 
 

 
Win 8 Ribbon Area 

8. ___ Take a moment and select each of the tabs at the top of Windows Explorer, File, 
Home, Share, View, and Manage to see how the content of the  menu options change for 
each tab. 
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9. ___ Close all Windows and then open Control Panel from the Apps window. 
10. ___ From the Control Panel select Appearance and Personalize and then Folder 
 Options and then Show Hidden File and Folders. 
11. ___ In Folder Options  select the View tab and then select “Show hidden files, folders, 
 or drives” and also remove the check from the box in front of  “Hide protected 
 operating system files”. You must select the Apply button for the new options to take 
 effect. 

 
Windows 8 Folder Options View Tab 

 
12. ____Close the Folder Options windows and open the Windows Explorer once more. Look 
 at the C: directory contents to see if there is any hidden content reveal. Hidden folders 
 will appear as a lighter in color folder. You may see hidden folders with names such as 
 ESD, Recovery, Program Files, and System Volume Information. 
13. ___ Close Windows Explorer and open the Folder Options windows once more. Select the 
 Restore Defaults option button to restore the system to its default condition of do not 
 show “hidden files and folders” and “hide protected operating system files 
 (Recommended)”. Then close the Folder Options window. 
14. ____ Open Windows Explorer once more and look at the folders under the C: partition. 
 The hidden folders should not appear this time. 
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15. ___ Select the Pictures folder under Libraries and view the contents of the folder. 
16. ____   Select the View tab at the top of the Ribbon area and then select the Details option. 
 You will see all folders and or files listed with default details such as Name, Date, and 
 Size. 
17. ___ Right-click at the top of the Name column and then select the more option from the 
 drop down menu list. 
18. ___ Select the following details, Attributes, Authors, Date last saved, and File   

  Extension. 
19. ___ See how the new details have been added to the Windows Explorer detail view. You 
 should see columns added for the selected details. If not, call your instructor for 
 assistance. 
20. ___ Right-click the top of the column once more but this time you should see the newly 
 added details in the drop down menu list near the top of the list. Remove the recently 
 added details, Attributes, Authors, Date last saved, and File Extension.  
21. ___ Take a moment to study the structure of the left navigation panel. Compare the 
 Windows 8 to the Windows 7 navigation pane contents. Look for the following folders, 
 Desktop, Downloads, Libraries, Documents, Homegroup, Computer, USERS and 
 the User Account you are currently using. 
22. ___ Take a few minutes to review the laboratory activity. Practice accessing the Folder 
 Options dialog box without the aid of your lab manual. 
23. ___ Complete the review questions. When you are finished answering the review question, 
 return the computer to its original configuration and shut down the computer. 
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Review Questions 
  
 
 1. Which Windows Explorer view allows you to sort files by type?  

 
2. Why are system files hidden by default?  
 
3. What does a plus sign in front of a folder in Windows XP directory tree mean?  
 
4. What is the path in Windows XP to the Folder Options dialog box starting from the Start  
menu?  
 
5. What is the path in Windows Vista, Windows 7 and Windows 8 to the Folder Options dialog 
box starting from the Start menu?  
 
6. How can you rearrange the detailed list of files in descending order by file size when viewed 
in Windows Explorer?  
 
7. Which operating system first introduced the Library feature?  
 
8. Which operating system first introduced the Public folder feature?  
 
9. Which operating system expanded the Public Folders feature to include multiple Public  
Folders?  
 
10. Which operating system first introduced Homegroup feature?  
 
11. Which two categories of folders or files are not displayed in Windows Explorer by default?  
 
12. What is the complete path from C: to My Documents for a user named Richard in a  
Windows 7 operating system?  
 
13.  What is the complete path to Folder Options in Windows 7?  
 
14. What is the complete path to Folder Options in Windows 8? 
 
15. Where is the User Accounts folder located in Windows XP?  
 
16. Where is the User Accounts folder located in Windows 7?  
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Review Question Answers 
 
 1. Which Windows Explorer view allows you to sort files by type? Details view. 

 
2. Why are system files hidden by default? Protect them from typical users who might disable a 
required file. 
 
3. What does a plus sign in front of a folder in Windows XP directory tree mean? There are 
more files. 
 
4. What is the path in Windows XP to the Folder Options dialog box starting from the Start 
menu? Windows XP – Right-click My Computer | Explore or Open 
 
5. What is the path in Windows Vista, Windows 7 and Windows 8 to the Folder Options dialog 
box starting from the Start menu?  
Windows Vista – Right-click Computer | Explore or Open 
Windows 7 – Right-click Computer Open 
 
6. How can you rearrange the detailed list of files in descending order by file size when viewed 
in Windows Explorer?  
 
7. Which operating system first introduced the Library feature? Windows 7 
 
8. Which operating system first introduced the Public folder feature? Vista 
 
9. Which operating system expanded the Public Folders feature to include multiple Public 
Folders? Windows 7 
 
10. Which operating system first introduced Homegroup feature? Windows 7  
 
11. Which two categories of folders or files are not displayed in Windows Explorer by default? 
System and hidden files. 
 
12. What is the complete path from C: to My Documents for a user named Richard in a 
Windows 7 operating system? C:\User\Richard\My Documents 
 
13.  What is the complete path to Folder Options in Windows 7? Start | Control Panel | 
Appearance and Personalize | Folder Options. 
 
14. What is the complete path to Folder Options in Windows 8? Search Charm |Apps | Control 
Panel | Appearance and Personalize | Folder Options. 
 
15. Where is the User Accounts folder located in Windows XP? Windows XP the User 
accounts were located under “C:\Documents and Settings” folder. 
 
16. Where is the User Accounts folder located in Windows 7? Windows Vista, Windows 7 and 
Windows 8 the User accounts are listed under the C: \Users or default drive partition under the 
“Users” folder. 


